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M E M O R A N D U M  

 
February 13, 2007 
 
To: HSI FILE 
 
From: Shawn Muenks 
 
Re: Southwest Missouri Hyperspectral Imagery (HSI) Lead/Zinc Re-analysis Project 
 
The following attachments provide a Scope of Work (SOW), related plans, and Standard 
Operating Procedures (SOPs) for the February 21 and 22, 2007 HSI project located in 
Southwest Missouri.  The plan will be modified as the project develops and or to 
accommodate field conditions. 
 
The purpose of this field analysis project is to collect surface data of lead and zinc 
concentrations for development of the Airborne Real-Time Cueing Hyperspectral 
Enhanced Reconaissance (ARCHER) system. The data from this field event will be used 
to calibrate previously acquired imagery for development of a “signature” for lead/zinc 
levels.  Once a “signature” is developed for varying concentration levels, the HSI 
configured aircraft can be used to locate and analyze surface contamination over large 
areas within a short amount of time. 
 
The surface concentrations will be recorded in-situ with a handheld X-ray Fluorescence 
(XRF) Spectrometer.  The locations of the tests will be recorded with a handheld Global 
Positioning System (GPS) unit. 
 
In summary, the objectives of the field analysis are as follows: 
• Obtain ground truth data for use in development of an electronic “signature” for 

varying surface concentration levels of lead and zinc. 
• Investigate mining areas to locate possible source areas or tailings piles. 
• Investigate and collect data from mine shafts. 
• Gather locational data of test locations and visual landmarks to use in rectifying 

imagery. 
 
SM 
 
Attachments: Scope of Work 
  Trimble Standard Operating Procedure 
  Standard Operating Procedure for Innov-X XRF Analyzer 
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Scope of Work for 
Southwest Missouri Hyperspectral Imagery (HSI) Lead/Zinc Re-analysis Project 

Aurora and Wentworth, Missouri 
Febuary 21 & 22, 2007 

 
BACKGROUND 
In December 2004, the department established a Cooperative Agreement (CA) with the 
University of Missouri Columbia (UMC) to support an Environmental Protection Agency 
(EPA) funded Pilot Project.  The Pilot Project, Characterizing Chemical Contamination 
through Airborne Hyperspectral Imagery (HSI), evaluated applications of the Civil Air 
Patrol's (CAP) new Airborne Real-Time Cueing Hyperspectral Enhanced Reconnaissance 
(ARCHER) system to the department's Environmental Emergency Response (EER) and 
contamination characterization requirements.  CAP deployed ARCHER to Jefferson City, 
August 7-9, 2005, and collected HSI of a variety of contaminated sites identified by 
department Project Managers (PM), including mining locations within the 
Aurora/Wentworth area.  The UMC, through the Missouri Resource Assessment 
Partnership (MoRAP), analyzed the HSI of select sites, in concert with the sites' PMs, to 
provide a preliminary assessment of applications.  There was not sufficient funding to 
conduct in-depth analysis of all sites or perform ground truth verification.  However, 
preliminary analysis indicated several promising applications for both EER and 
contamination characterization. 
 
PURPOSE 
The purpose of this phase of the HSI project is to perform a field ground truth survey of 
the Aurora and Wentworth HSI imagery areas to confirm/disprove the ability of the 
ARCHER system to characterize lead contamination in surface soils and/or vegetation.  
Field screening data will be collected and compared to the imagery analyses previously 
provided by MoRAP.  Lead and zinc concentration levels will be used to calibrate the 
spectral imagery to known in-situ ground conditions.  The ARCHER system will then be 
adapted to conduct field screening for general distribution, and possibly concentration 
levels of mine waste and other contaminants with distinguishable spectral signatures. 
 
SCOPE SUMMARY 
TASK I: Conduct site visit planning meeting 
TASK II: Develop field survey plan 
TASK III: Collect field data 
TASK IV: Data analyses and report generation 
 
TASK I DESCRIPTION: CONDUCT SITE VISIT PLANNING MEETING 
Federal Facilities Section (FFS) staff will meet with MoRAP to discuss re-analysis of 
imagery for Southwest Missouri mining area.  MoRAP will be tasked with charting a 
map with varying levels of contamination in order to identify areas for field ground truth 
surveying.  This information will be used to map out specific geographical locations to 
collect readings of lead and zinc for comparison to the spectral imagery.  Areas of high, 
medium, and low lead concentrations will attempt to be identified for field surveying. 
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TASK II DESCRIPTION:  DEVELOP FIELD SURVEY PLAN 
Information provided by MoRAP will be used by FFS staff to choose geographical 
locations for field data collection.  Areas will be chosen with high, moderate, and low 
levels for the field survey.  If time constraints are encountered, only the high levels will 
be surveyed.  Areas to be surveyed will be located on a map using ArcView mapping 
software and imagery layers provided by MoRAP.  Locational data will be recorded and 
downloaded into a handheld Trimble Geographical Positioning System (GPS).  The GPS 
will be used to locate the survey points in the field. 
 
TASK III:  COLLECT FIELD DATA 
The survey points will be located in the field and a handheld X-ray Fluorescence (XRF) 
Spectrometer will be used to record the in-situ surface soil concentrations for lead and 
zinc.  The geographical location of each XRF test will also be recorded in the field using 
the same GPS unit.  Vegetation within the area of contamination will also be analyzed 
with the XRF utilizing the thin-film analysis tool of the XRF.  All test locations, mining 
features, and other landmarks will be recorded using the GPS unit.  Standard Operating 
Procedures (SOPs) for these devices is included in the attachments. 
 
The goal of the field survey is to obtain ground truth data for use in development of an 
electronic “signature” for varying surface concentration levels of lead and zinc.  In 
addition, data from mining features such as shafts or tailings piles will be recorded for 
use in developing spectral signatures for the ARCHER system. 
 
TASK IV:  DATA ANALYSES AND REPORT GENERATION 
Once the field survey is complete, all data will be downloaded and analyzed for any 
reoccurring trends that can be attributed to the output of the spectral imagery.  The GPS 
locations of the XRF field tests will be plotted over the spectral imagery and compared 
with lead and zinc concentrations to identify areas of similar spectral signature.  Surface 
metals data for designated areas and for non-contaminated areas will be plotted for 
analyses.  Also, areas of lead and zinc contamination in vegetation will be plotted and 
compared with the spectral imagery to see if there are trends within the imagery that 
correlate to the contamination.  Locations of mine features such as shafts and tailings 
piles will also be plotted to identify any characteristics that appear in the imagery.  GPS 
coordinates of designated landmarks will also be given for geo-referencing of the 
imagery. 
 
A final report will include all findings and present any recognizable signatures from the 
imagery.  The metals data will be presented along with locational information for follow-
on analysis.  The results of the investigation will be used to gain confidence in the 
ARCHER system for use as a field screening tool in Southwest Missouri, and mine waste 
inventory applications in general. 
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TRIMBLE STANDARD OPERATING PROCEDURE 
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Battery 

Satellite Icon 
(GPS receiver on and 5 satellites 

have been acquired) 

Section List 
(Showing “Status” 

Section) 

Subsection List 
(Showing “Skyplot” 

Subsection) 

Section List 
(Showing “Data” 
Section) 

Subsection List 
(Showing “New” 

Subsection) 

File Type 
When creating a new 

data file, always select 
“Rover”. 

File Name 
Type in the name of your site in 
the following way: 

YYYYMMDD_site_name 
(For example: 

20040525 Wet Willy’s Wells)

Dictionary Name 
Select the data dictionary to 

use for this file.  
SAU_Data_Dictionary 

should be used at most sites. 

Satellite Icon 
(GPS receiver is on, but no 

satellites have been aquired)

Input 
Pan
el 
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Questions and Answers for the Basics 
 
 

1. How do I turn the Trimble handheld unit off and on? 
To turn on, press the large button below the screen.  Press and release, do not hold the button.  To 
turn off, press and release the large button below the screen.  (See cover page) 

 
2. How do I check the battery power? 
 Double click the battery icon on the lower right hand side of the screen. 

 
 
3. How do I recharge the unit? 

Plug module into outlet, turn on the unit and place it into the black support module as shown and 
leave unit turned on: 

 

 
 
4. Why is the screen so dark? 

The backlight may be turned off.  Press the small button below the screen with the light bulb icon.  
If that doesn’t work, press and hold the same button until the desired setting is reached.  (See 
cover page) 

 
5. How do I access the keyboard on the Trimble? 

Tap on the keyboard icon in the lower right hand portion of the screen.  To close the keyboard, tap 
on the X on the top right portion of the “Input Panel.”  (See cover page and page 2) 

 
6. How do I open TerraSync software? 

Double click the TerraSync icon on the desktop.  The program loads slowly.  Wait approximately 
five seconds for the program to load.  (See cover page) 

 
7. How do I turn on the GPS receiver? 

With TerraSync software open (see 6 above), tap the down arrow on the Section List (usually 
reads “Status”).  Select “Setup.”  The Current Configuration screen is opened.  On the top right of 
this screen is a button with “GPS” on it.  Tap this button.  A small satellite icon will appear to the 
right of the “Setup” menu.  The GPS receiver is now on (see page 2). 

 
8. How do I turn off the GPS receiver? 

With TerraSync software open, tap the down arrow on the Section List.  Select “Setup.”  The 
Current Configuration screen is opened.  On the top right of this screen is a button with “GPS” on it.  
Tap this button.  A message window opens and asks you if “you are sure you want to disconnect 
from the GPS receiver?”  Tap “Yes.”  The small satellite icon will disappear to the right of the 
“Setup” drop down menu.  The GPS receiver is now off. 
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9. How do I know when poor satellite geometry will occur at my site? 
Run Mission Planning when you arrive at your site  (you only need to run this once per day).  With 
TerraSync software open and the GPS receiver turned on, tap the down arrow of the Section List 
and select “Status”.  Select “Plan” from the Subsection List.  This could take several minutes to 
complete.  The Trimble has to figure out where it is and then (automatically) get information from 
the satellites in order to run the plan.  You may see one of the following messages displayed during 

this time: 
After the unit receives the information it needs, you will see something similar to the picture 
below. 
 

At the bottom of the screen is a graph with PDOP values on the left and time on the bottom.  In the 
enlarged example below you can see a yellow and red bar from 4pm to 5pm and a green bar around 
10:30pm.  The PDOP exceeds the maximum DOP value in these two instances and you would not be 
able to collect positions during these times.  Around 8pm, there aren’t enough satellites to collect 
positions and you would not be able to collect positions during this time.  Plan your data collection 
during the cyan colored portions of the graph. 
 

 

Message

Poor satellite geometry 
during this time. 
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Standard Operating Procedure for Innov-X α 400sl XRF Analyzers 

 
The guidance for safe instrument operation described in the manufacturer’s manual will 
be followed.  In addition, to ensure consistent use of the instrument among department 
personnel, the following protocol will be followed.  
 
Note about trigger lock:  If the analyzer is not used for a period of time, the trigger lock 
will automatically engage.  To unlock, click on the lock icon in the lower right hand 
corner of the screen while in the “Ready to Test” screen. 
 
Startup (handheld operation) 
• Place a battery in the handle of the analyzer. 
• Power up the analyzer (On/Off switch located on base of handle), then the iPAQ 

Pocket PC. 
• Start the Innov-X software using the icon in the Start dropdown file on the iPAQ. 
• A “NOTICE” screen will pop up warning about ionizing radiation, hit START. 
• The Innov-X Main Menu screen appears, choose which mode you wish to test in.  

Available modes will be highlighted. 
• The instrument will automatically perform a hardware initialization procedure, which 

lasts for 60 seconds. 
• Following initialization, the software will prompt you for Standardization, place the 

stainless steel standardization clip over the nose of the analyzer.   
• Tap the “Standardize” button on the iPAQ screen.  The instrument will perform an 

internal 60-second standardization procedure.  During standardization, and any other 
time the x-ray tube is on, the red light on the top of the analyzer will flash.  When the 
x-ray tube is off, the red light will remain on solid.  Do not remove the probe end of 
the analyzer from the test surface when the light is flashing.  It is not dangerous to do 
so, but it will prematurely stop the analysis. 

• Following standardization, a window will pop up displaying the analyzer resolution.  
Record the resolution if so desired, hit OK.  

• The analyzer is now ready to analyze calibration check samples (NIST standards). 
 
Calibration Check (handheld operation) 
• The NIST Low (2709), NIST Medium (2711), NIST High (2710), or RCRA (408) 

soil calibration check samples will be analyzed at the beginning of each use (e.g. 
beginning of the day and at each start up), followed by the certified blank sand 
sample.  Choose the standard which is closest to the anticipated range of the media to 
be tested. 

• On the iPAQ screen, hit the “Info” button at the bottom of the screen.  A data entry 
window will pop up allowing input of information about the next test.   

• Fill in the appropriate information using the dropdown menus or type in information 
using the touch pad keyboard (use the keyboard icon at the bottom of the screen to 
toggle between the keyboard and input screen). 

• Click OK 



ATTACHMENT 3 – COLLECTION PLAN FOR SW MISSOURI LEAD/ZINC 
PROJECT 

A3-9 

• Place a calibration check sample cup on a smooth surface with soil material facing 
up.  Place the test window of the analyzer over the sample and pull the trigger or hit 
the “Start” button on the iPAQ screen. 

• The screen will display the words “Test in progress” and the time elapsed.  The word 
“Testing” will blink on and off in the low right hand corner of the screen and the red 
light will flash. 

• Assess instrument calibration by comparing the measured values to the certified true 
values on the charts located in the analyzer carrying case.   Measured values present 
above the instrument levels of detection must be within 20% of the true.    

• If values above 20% of true are observed, re-analyze the calibration check sample.  If 
the measured value still exceeds 20% of true, power the XRF off, close the iPAQ 
software and shut it down also, wait 10 seconds, and power them back up, and re-
initialize and re-standardize as described above.  Re-analyze the standards.   

• A blank sand sample should be analyzed at least once per 20 samples, preferably 
following a high concentration sample. 

• Re-standardize each instrument a minimum of once each 4 hours of operation or 
when there is an extreme change in ambient conditions such as temperature.  
Standardization can be accessed from “File” tab at the bottom of the screen. 

• The calibration check standards will be analyzed approximately mid-way through 
sample analysis (e.g. mid-day), again at the end of sample analysis, and anytime the 
instrument is re-standardized. 

 
In-Situ Sample Analysis 
• Before taking an in-situ test with the analyzer, be sure to check the “Info” screen for 

information about the next test.  This screen can be accessed by hitting the “Info” 
button on the Ready to Test screen or by hitting “Edit” at the bottom of the screen and 
choosing “Edit Test Information”. 

• Fill in the appropriate information using the dropdown menus or type in information 
using the touch pad keyboard (use the keyboard icon at the bottom of the screen to 
toggle between the keyboard and input screen). 

• Click OK 
• Next choose the length of testing time from the “Options” tab at the bottom of the 

screen. 
• Choose “Set Testing Times” from the “Options” menu.  Set the Maximum testing 

time for the Standard Test (The minimum testing time should be set for 10 seconds 
and a typical maximum testing time would be 30 or 60 seconds for a Standard Test.  
Longer testing times may be chosen, but will not improve results significantly.  Do 
not change settings for Light Element Test). 

• Click OK 
• Point the analyzer to the surface to be tested.  Any foreign objects should be cleared 

away and the analyzer should be held such that the front of the probe head is held 
flush to the surface. 

• Pull the trigger or tap the “Start” button on the Ready to Test screen. 
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• The screen will display the words “Test in progress” and the time elapsed.  The word 
“Testing” will blink on and off in the low right hand corner of the screen and the red 
light will flash.  The test will continue for the amount of time specified. 

• It is recommended that the window be carefully wiped clean after each analysis or 
clear plastic used to protect the test window.  The window should also be checked 
periodically to ensure it is not ripped or punctured. 

• The results of the analysis will be displayed on the screen after each test.  If the 
results do not appear, tap the “View” tab at the bottom of the screen and choose 
“Results”. 

• If necessary, tap the X in the upper right hand corner of the Results screen to return to 
the Ready to Test screen at any time. 

• Tests can be stopped by either pulling the trigger again, or tapping Stop on the iPAQ 
screen. 

• When finished analyzing, exit out of the software by tapping on the “File” tab at the 
bottom of the screen and choosing “Exit”.  You may have to repeat this two times to 
exit the Innov-X software. 

 
Basics 
• Innov-X software uses three main screens: Main, Analysis and Results: Users select mode 

to use via the Main screen.  Most edits to testing method are made via the Analysis screen, 
which typically says “Ready to Test”.  The Results screen shows all data.  All data editing 
features are done from here. 

• Always exit software completely when finished using the analyzer!  It may be necessary 
to close all three screens.  Use File ∏ Exit.  Software sill prompt for confirmation before 
closing. 

• Removing iPAQ: Slide iPAQ towards nose of analyzer to clear connector before lifting 
upwards. 

Note:  For any operation that requests a password, the administrator password is 
lower case z, and the factory password is 1234. 
 
Downloading Data 
Exported data is saved as comma delimited (.csv) files.  These files can be opened and 
formatted in MS Excel, or any other spreadsheet program.  To transfer data to a PC, 
ActiveSync must be installed on the PC. 
• Insert iPAQ in cradle connected to PC.  Choose “Guest” partnership. 
• Open Innov-X software from the Start dropdown menu. 
• Tap START on the “NOTICE!” screen. 
• Choose View ∏ Results (at the bottom of the iPAQ screen). 
• Choose File ∏ Export Results (at the bottom of the iPAQ screen). 
• Select readings to be exported using the choices given.  Tap OK. 
• Input Filename, folder, tap OK. 
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The results file will be stored in the My Documents Folder on the iPAQ.  It can be 
copied to the PC by using “My Computer” and navigating to the file by clicking on 
the “Mobile Device” icon. 
 
 
 


